
DSP First, 2e Signal Processing First

Lab 15c: Cochlear Implant Simulation with a Filter Bank

Pre-Lab andWarm-Up: You should read at least the Pre-Lab and Warm-up sections of this lab assignment
and go over all exercises in the Pre-Lab section before going to your assigned lab session.

Verification: The Warm-up section of each lab must be completed during your assigned Lab time and
the steps marked Instructor Verification must also be signed off during the lab time. One of the laboratory
instructors must verify the appropriate steps by signing on the Instructor Verification line. When you
have completed a step that requires verification, simply demonstrate the step to the instructor. Turn in the
completed verification sheet to your instructor when you leave the lab.

Lab Report: Write a lab report on Section 4 with graphs and explanations. Please label the axes of your
plots and include a title for every plot. In order to keep track of plots, include each plot inlined within your
report. If you are unsure about what is expected, ask the instructor who will grade your report.

1 Introduction

A Cochlear Implant (CI) serves to overcome deafness by directly stimulating auditory nerve fibers with
electrical current thereby conveying auditory cues. The goal of this lab is to emulate the speech processing
function of a cochlear implant.1;2 To better understand the internal functions of a cochlear implant device,
it is useful to review the process of hearing. The ear is divided into three parts: outer, middle and inner as
shown in Fig. 1a. During the process of normal hearing, the outer ear captures sound, which the middle ear
then converts into mechanical vibrations. These vibrations travel into the cochlea, a coiled fluid-filled tube,
located in the inner ear. Dividing the fluid-filled tube is a membrane, the basilar membrane that exhibits
a variable mechanical stiffness. As a result, it is more sensitive to high frequencies at the base, and more
sensitive to low frequencies near the apex (see Fig. 1b). The fluid displacement reveals (or encodes) the
frequency information of the acoustic signal. Attached to the membrane are small hair cells lined with
stereocilia that bend when the membrane is displaced. When bent, these hair cells activate neurons that
fire signals to the brain relaying acoustic information. Deafness is caused by the disruption of this hearing
process. In the majority of the cases, it is the hair cells that are damaged, not the auditory nerves. A cochlear
implant functions by directly stimulating the auditory nerves with patterns of electrical current determined
by speech processing.3;

4

Figure 2a depicts the four external parts of a cochlear implant. Understanding the signal processing
inside the speech processor is the focus of this lab. Figure 3 shows a block diagram of the major signal
processing blocks.

1P. T. Bhatti and J. H. McClellan, “A Cochlear Implant Signal Processing Lab: Exploration of a Problem-Based Learning
Exercise,” IEEE Transactions on Education, Vol. 54, No. 4, pp. 628–636, 2011. DOI: 10.1109/TE.2010.2103317

2C. Luo, J. H. McClellan and P. T. Bhatti, “Introductory signal processing labs based on filterbank applications,” 2011 IEEE
Digital Signal Processing Workshop and IEEE Signal Processing Education Workshop (DSP/SPE), Sedona, AZ, pp. 90–94, 2011.
DOI: 10.1109/DSP-SPE.2011.5739192

3P. C. Loizou, “Introduction to Cochlear Implants,” IEEE Engineering in Medicine and Biology Magazine, Vol. 18, No. 1, pp.
32–42, 1999. DOI: 10.1109/51.740962.

4A tutorial article can be found here (April, 2016): http://ecs.utdallas.edu/loizou/cimplants/tutorial/
P. C. Loizou, “Mimicking the human ear,” IEEE Signal Processing Magazine, Vol. 15, No. 5, pp. 101–130, 1998. DOI:
10.1109/79.708543
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(a) Peripheral auditory system. (b) Frequency-to-place mapping of the cochlea.

Figure 1: (a) The ear is divided into an outer, middle, and inner ear. The cochlea is located in the inner ear.
(b) Different acoustic frequencies activate different parts of the basilar membrane, and therefore the cochlea.
The acoustic frequency as a function of place is indicated in Hz.

(a) External parts of a cochlear implant. (b) Internal parts of a cochlear implant.

Figure 2: Cochlear Prosthesis Components. (a) External components are (1) microphone, (2) external speech
processor, (3) cable to transmitter, (4) transmitter coil. (b) Internal components are (5) receiver/stimulator,
(6) electrode array, and (7) vestibulocochlear nerve.

2 Pre-Lab

In this lab, the student will hear sounds that emulate what a patient with a Cochlear Implant (CI) hears.
A sound file will undergo speech processing similar to that of a cochlear implant. The following sections
describe the major signal processing blocks needed to decompose a speech (or audio) signal into frequency
components that are consistent with the frequency-to-place mapping of the cochlea.

2.1 Cochlear Implant Signal Processing

The external parts of a cochlear implant consist of a microphone, a speech processor, a transmitter/receiver,
and an electrode array as shown in Fig. 2a. The speech processor is the function that can be emulated
in Matlab. There are four steps in cochlear speech processing: Pre-emphasis, multiple band pass filters
(BPFs) in a filter bank structure, envelope detection, and bipolar pulse generation. Figure 3 shows the signal
flow through these blocks. The last step, bipolar pulse generation, is needed to produce the appropriate
signal to send to the current stimulator, and then onto the electrode array, causing nerve stimulation. This
step (of current stimulation) will not be duplicated in the Matlab code. Instead, the fourth step is envelope
modulation and summation of the channels, which allows the processed sound to be heard.
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Figure 3: Multi-channel filter bank for analyzing speech; sixteen channels shown.

Table 1: Center frequencies and bandwidths for an 8-channel filter bank (frequencies in Hz)

n 1 2 3 4 5 6 7 8
fc 394 692 1064 1528 2109 2834 3740 4871
B 265 331 413 516 645 805 1006 1257

2.1.1 Pre-emphasis Filter

A pre-emphasis filter is often used to amplify high frequencies and attenuate low frequencies prior to the
rest of the processing. This filtering enhances the low-energy, high-frequency consonants with respect to
the high-energy, low-frequency vowels in a speech signal. A simple FIR filter such as a first-difference
filter can provide this capability. Recall that a first-difference filter would completely remove DC from the
input speech waveform. The low frequency cutoff for human hearing is generally taken as 20Hz and most
microphones and speakers used on PCs are unable to record or play frequencies in these low ranges anyway.

2.1.2 Bandpass Filter Bank

At this point in the speech processing, the pre-emphasized sound waves are separated into parallel channels
that are narrow frequency bands. Table 1 gives the center frequency and bandwidth values for an 8-channel
filter bank. Each channel in the filter bank employs a bandpass filter (BPF) to separate out a small range of
frequency components of sound signal, i.e., the frequencies within its pass band. The pass band of each BPF
is from fc �

1
2
B to fc C 1

2
B , so the width of the pass band is B . For example, the seventh channel in the

8-channel system given in Table 1 has a BPF that passes frequencies from 3237Hz to 4243Hz.
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When designing the CI filter bank, a major question would be how many frequency channels to use,
and how to choose the passband width of the channels. With too few channels the reconstructed sound
will be unintelligible; however, with too many channels the computational load from the signal processing
is too great which makes it difficult the implement a real-time system that is (relatively) inexpensive and
has low power dissipation for longer battery life. The choice of center frequencies and bandwidths for the
filter bank must be consistent with human perception that depends on the frequency-to-place mapping of the
cochlea. Therefore, it turns out that the bandwidths (B) of the filter banks are logarithmically spaced, i.e.,
the difference between successive log.B/ values is constant. Equivalently, the ratio between bandwidths of
successive channels is constant.

2.1.3 FYI: Defining the Channel Bandwidths

The BPF specifications were derived in a study examining the number of channels needed to understand
speech.5 Here is a simple algorithm for choosing the bandwidths in a constant-bandwidth-ratio N -channel
filter bank:

1. Determine the minimum and maximum frequencies to be covered by the filter bank, say Œfa; fb�.

2. The bandwidths of neighboring channels are defined as Bn D �Bn�1, where � is a constant (greater
than one) that defines the ratio of successive bandwidths. Decide on values for N and �, e.g., in the
8-channel filter bank of Table 1, � D 5=4 D 1:25, and Œfa; fb� D Œ262; 5500�.
Note: the numbers in the table were obtained by rounding fc and B to integer values.
The sixteen-channel case is � D 9=8 D 1:125, and Œfa; fb� D Œ156; 5500�; while the four-channel
case is � D 2:07, and Œfa; fb� D Œ300; 5500�

3. Knowing N , � and Œfa; fb�, we can solve for B1 from the following:

fb � fa D

NX
nD1

Bn D

NX
nD1

�n�1B1 D B1

N�1X
nD0

�n
D B1

1 � �N

1 � �

Recall that the bandwidths are then generated from the recursion Bn D �Bn�1.

4. Finally, the center frequencies are generated via:

fc1
D fa C

1
2
B1 and fcn

D fcn�1
C

1
2
Bn�1 C

1
2
Bn

2.1.4 Envelope Detection

Once the pre-emphasized speech signal has been separated into sub-band channels by bandpass filtering,
detection of the envelope for each sub-band signal is necessary. Each BPF output is modeled as a narrowband
signal consisting of a slowly varying envelope signal that multiplies the high-frequency sinusoid whose
frequency equals the center frequency of the sub-band channel. This model is, in effect, an AM (amplitude
modulation) representation of the narrowband signal. Envelope extraction requires two steps: full-wave
rectification and low-pass filtering. Full-wave rectification obtains the instantaneous magnitude of the sub-
band signal and then low-pass filtering then smooths out the signal, and thus removes the high frequency
nature of the sinusoid at the center frequency.
Note: The envelope is needed because it is a low-bandwidth signal that is used to modulate the current pulses
that stimulate nerve fibers as described in Section 2.1.5.

5P. C. Loizou, et. al., “On the number of channels needed to understand speech,” J. Acoustical Soc. of America, vol. 106, pp,
2097–2103, 1999.
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2.1.5 Envelope Modulation

The external signal processor for the cochlear implant produces the envelope signals, one for each channel,
and then transmits these signals to the internal receiver which can then use the envelopes to stimulate auditory
nerve fibers at different locations along the electrode array. Amplitude-modulated biphasic signals are used
to stimulate with a current output at each electrode site. Location along the cochlea maps to frequency, so
each frequency band in the filter bank is assigned to an individual electrode position. For example, the first
channel (lowest frequency) in the filter bank corresponds to the most apical (deepest) electrode site, hence
the lowest frequency for stimulation (see Fig. 1b). Similarly, the highest-frequency channel in the filter bank
corresponds to the most basal electrode site, the highest frequency.

Signal processing blocks cannot simulate the interaction between the electrodes and the auditory nerve
fibers that create the different frequency sounds we hear. Instead, we must create an acoustic simulation of
a CI signal processor, meaning that our simulation should attempt to be “acoustically faithful.” We use the
slowly varying envelope signal from each channel to restore a signal at the center frequency of that channel,
i.e., the envelope for the n-th channel modulates a sinusoid whose frequency is set to the center frequency
of the n-th channel.6 The sinusoids from all the channels are then summed to produce a speech signal that
emulates what is heard by a patient with a cochlear implant.

2.2 GUI for Filter Design

The Matlab GUI called filterdesign illustrates several filter design methods for LPF, BPF and HPF
filter. The interface is shown in Fig. 4. If you have installed the SP-First (or DSP-First) Toolbox, you should
already have this demo on the matlabpath.

Both FIR and IIR filters can be designed, but we are only be interested in the IIR case which would be
selected from the radio button in the upper right. Once IIR Filters is selected, the filter specifications
can be entered in the text boxes on the right. For the bandpass filter shown in Fig. 4, the lower stopband
extends from 0 to 530Hz, and the upper stopband from 1185 to 2756.25Hz which is half the sampling rate.
The value of the magnitude (of the frequency) response in the stopbands must be less than 0.1 which is the
specified stopband deviation, ıs . The passband of this filter goes from 697 to 941Hz and the magnitude
response must be between 1 and 1 � ıp where ıp is the allowable deviation in the passband. Lastly, it is
necessary to set the order of the IIR filter which is the number of poles. The order can be set manually, but
it is also possible to obtain the order from a formula that is built in to the GUI.

2.2.1 Design Some IIR Filters

For practice, design some bandpass IIR filters where the 3-dB passband goes from 0:3� to 0:35� in the O!
domain. In the first case set the order to 2, i.e., two poles. Set the stopbands to be Œ0; 0:2��, and Œ0:45�; ��.
Use the Show Radian Frequency under the Edit menu to get the O!-axis. Notice that this filter does not
satisfy the specifications, so determine the actual stopband edges.

Next, set the GUI to Auto Order to see that a filter can be obtained to meet the specs by increasing the
order. Determine where the poles and zero of this filter lie, and verify that the number of poles equals the
filter order. A pole-zero plot can be viewed by right-clicking on the frequency response plot to bring up
a context menu with other plots. Finally, the filter coefficients can be exported to the workspace by using
the Export Coeffs under the File menu. With the filter coefficients in the workspace, the Matlab function
roots can be used to find the roots of the numerator and denominator polynomials, i.e., the zeros and poles.

6In reality “The amplitudes of the sinusoids are computed by estimating the root-mean- square (rms) energy of the envelopes
every 4 msecs.” Loizou ref.
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Figure 4: Interface for the filterdesignGUI. The default setting for the frequency axis is analog frequency
f in Hz, but can be changed to O! via the Edit->Show Radian Frequencymenu selection. When the Filter
Choice is set to IIR Filters, the design method gives a Butterworth filter to meet the ripple specifications
(ıp and ıs) which are shown as red horizontal lines in the frequency response plot.

2.3 IIR Bandpass Filter Design

You need a bandpass filter design function for this lab. Second-order IIR bandpass filters can be obtained
directly from the poles and zeros. In a previous lab, you may have experimented with second-order IIR filters
whose frequency response looks like Fig. 5.

(a) Write a few lines of Matlab code to make the plot in Fig. 5(a), where the frequency axis is O!.

(b) Modify the code in part (a) to change the frequency axis to get the plot in Fig. 5(b). Recall that the
relationship between analog frequency and digital frequency is O! D 2�.f=fs/.

3 Warm-up

3.1 Pre-emphasis Filter

Create a pre-emphasis filter to amplify the high-frequency sound content of a signal.

(a) Define a pre-emphasis filter as H.z/ D 1 � z�1, which is a first-difference FIR filter. Make a plot of
its frequency response (magnitude only) by using freqz and plot. Notice what type of filter H.z/
is, i.e., FIR or IIR; and also desribe its frequency characteristic as LPF, HPF, BPF, or something else.
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Figure 5: Frequency response of a second-order IIR bandpass filter (BPF) created inMatlabwith numerator
bb = 0.01*[1,0,-1]; and denominator aa = poly(0.95*exp(j*0.3*pi*[1,-1]));. (a)

ˇ̌
H.ej O!/

ˇ̌
plotted versus O!, and (b) the same frequency response versus analog frequency f (Hz), assuming that
fs D 8000 Hz.

(b) ApplyH.z/ to a speech signal, e.g., catsdogs.wav. To show the effect of the filter, make spectrograms
of both the input signal and the output signal. Describe at least two features in the spectrograms that
confirm the frequency response behavior of the pre-emphasis filter.

Instructor Verification (separate page)

(c) Listen to the speech signal before and after pre-emphasis. Describe the difference that you hear in
high-frequency spectral content? High-quality headphones would make this easier.

3.2 Envelopes via Full-Wave Rectification and Lowpass Filtering

The output of each BPF in a filter bank is a narrowband signal because it has frequency components only
near the center frequency of the BPF. An approximate model for the narrowband output signal is the AM
model that expresses the signal as the product of two components: a sinusoid at the center frequency of the
channel and a slowly varying (nonnegative) envelope that changes the amplitude of the sinusoid versus time.
This representation is approximate, but the AM (amplitude-modulated) sinusoid is well understood, so the
model is easy to work with.

The objective in envelope extraction is to separate out the slowly varying envelope signal from the high
frequency sinusoid (at the center frequency of the BPF channel). The envelope signal has its spectrum
centered at zero frequency and is a signal with relatively low bandwidth. One common way to extract the
envelope is to use a cascade system consisting of a full-wave rectifier (i.e., a magnitude device) followed by
a lowpass filter. These two operations are treated in more detail in this part of the warm-up.

To demonstrate the processing we need a test signal that is the product of two components: a slowly
varying component and a much higher frequency component. The simplest example of this sort is the AM
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signal studied in Chapter 3 and given below

b.t/ D b1.t/b2.t/ D .ˇ C cos.2�f1t C '1// cos.2�f2t C '2/ where f1 � f2

where b2.t/ is a high-frequency sinusoidal signal. The slowly varying signal b1.t/ controls the amplitude
of the sinusoid b2.t/. This behavior would be obvious from a plot of b.t/ versus t .

Extracting the envelope signal, which is b1.t/ in this case, from b.t/ can be done with two simple
processing steps: (1) a magnitude operator, and (2) a lowpass filter. In a hardware implementation, a
full-wave rectifier would be used to perform the magnitude operation.

(a) Generate an amplitude-modulated sinusoid using

b.t/ D .ˇ C cos.2�f1t // cos.2�f2t /

Pick f1 D 215Hz, f2 D 1064Hz, and ˇ D 1:2, which corresponds to the third channel in the
8-channel filter bank. Use a sampling rate of fs D 8000Hz to create the vector of signal values in
Matlab; call it bt. Create the signal vs. time for a duration of 1.3 s. In a plot of the signal, zoom in
to find the feature of the plot that is the envelope of the signal.

(b) In Matlab take the magnitude (i.e., absolute value) of bt and plot the magnitude signal versus time
t . Once again zoom in to see details, and then point out the feature of the signal that is the envelope.
Notice that you can also see the detailed high-frequency nature of the signal.

(c) Compare two-sided spectrograms of b.t/, b1.t/ and jb.t/j to see where these three signals have
frequency content. Note: You might have to use a long window length, e.g., 512 or 1024, to see
the individual spectrum lines. Use the two-sided spectrograms to justify that a LPF applied to the
magnitude signal jb.t/j does, in fact, yield the envelope b1.t/. In addition, use the spectrograms to
define where the passband and stopband edges need to be for the LPF. In particular, how does the
stopband edge depend on center frequency of the BPF channel?

Instructor Verification (separate page)

(d) Since lowpass filters are well-known for making signals smooth, we need a LPF that passes the
frequency range where we expect to find the envelope signal, and rejects the frequency range where
the high frequency components lie. The spectrograms done in the previous part should aid in choosing
the passband and stopband edges of this LPF.
Use the filterdesign GUI to create a LPF with its cutoff frequency at an appropriately chosen
cutoff frequency. The IIR-LPF should have no more than three poles. Since the filterdesign GUI
can take inputs that are analog frequencies, the cutoff frequency can be chosen directly in hertz. Use
the GUI’s plot of the frequency response to verify the correct locations of the passband and stopband.
Finally, show the pole-zero plot (in the GUI) for the system function of the lowpass filter.

Instructor Verification (separate page)

(e) Export the filter coefficients from the GUI in order to use themwith the filter function to process the
magnitude signal jb.t/j.7 Make a plot of the output signal from the LPF, which should be the filtered
magnitude. Compare this output to the expected shape of the envelope. Point out similarities and
differences; be aware that there might be a fixed scaling between the two plots. Notice the transient
portion of the output signal at the beginning of the output signal—this is an interval where the output
signal is unlike the rest of the waveform.

Instructor Verification (separate page)

7The GUI can export to the default names num and den; sometimes, the numerator coefficients are negated.
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4 Lab Project

First, an observation about learning in the context of lab projects. For first-year or second-year students, labs
are given with lots of step-by-step instructions. However, in the “real world” projects typically come with
little or no detailed instructions. Thus, a valuable learning experience is to attempt occasionally a project
without much hand-holding. If that were the case, this write-up could actually be no more than the following
three-sentences.

Implement the entire signal processing system shown in Fig. 6 for simulating the cochlear
implant system. Once you have the system working, run tests on several types of input signals,
including male/female speech and music. Finally, vary the number of channels in the filter bank
and compare the results.

4.1 Special Considerations

The foregoing description might be a bit too terse, so here are some issues to consider.

Figure 6: Acoustic simulation of the multi-channel filter bank for a cochlear prosthesis.

4.1.1 Sampling Rate

Although many of the previous labs have used speech signals sampled at fs D 8000Hz, for this lab a higher
sampling rate must be used because the highest frequency BPF in the filter bank has a passband that extends
up to 5500Hz. Furthermore, the magnitude operator used in envelope extraction is a nonlinear system that
produces even higher-frequency spectral components. The best choice would be fs D 22 kHz or greater, so
make sure that your implementation works for these sampling rates.

These rates are a convenient choice because it is relatively easy to acquire a recording atfs D 22:05 kHzor
fs D 44:1 kHz which are common rates related to the sampling rate used on CDs. You can increase/decrease
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the sampling rate by using the Matlab M-file called resample, e.g., you could change from fs D 8000Hz
to fs D 22 kHz by using a rate-conversion factor of 11

4
. From a previous lab you might have a recording of

your own voice that you may have already studied, so that signal could be used for some of the evaluations
below. Other recordings are available from the resource area of the DSP First Companion Website.

4.1.2 Components Available

In the warm-up, the pre-emphasis filter and the envelope extraction processes were studied. Assuming that
you have successful implementations of these components, only minor modifications should be needed to
use them in the final system simulation.

4.2 Complete Simulation of the Cochlear Implant System

The CI system requires many filters, so filter design is the core activity in this lab project.

4.2.1 Implement the Filter Bank with IIR BPFs

The filter bank consists of many IIR-BPFs running in parallel. In Table 1, we see that the passband widths
of the filters are all different. In the IIR case, second-order IIR bandpass filters can be designed by selecting
the pole angle from the center frequency of the passband, and the pole radius from the passband width.
Thus it is necessary to write a loop that takes the center frequency and bandwidth of each channel, and then
determines the radius and angles of the two poles for each IIR filter. Plotting all the frequency responses
together would illustrate how the channel BPFs cover the entire band of the input signal. The implementation
of the filter requires filter coefficients when calling Matlab’s filter function to process the signal. The
filter coefficients can be determined from the poles and zeros.

4.2.2 Envelope Extraction

The output of the BPFs are narrowband signals that can be viewed as the product of a slowly varying envelope
signal with a high-frequency sinusoid at the center frequency of the BPF. The slowly varying envelope signal
can be extracted in a two-step process by taking the magnitude and then averaging with a smoothing LPF.

(a) A lowpass filter (LPF) is used because the valuable frequency content of the slowly varying envelope
signal is concentrated in the low-frequency region. TheLPF should be designed as a 3-poleButterworth
IIR LPF with the filterdesignGUI so that the passband can be controlled to be flat over a relatively
wide frequency band. One question that must be addressed is whether to use a different LPF for each
channel, i.e., different passband edges. The following approaches could be studied: (1) use the same
LPF in each channel, (2) use several different LPFs, e.g., one for the very narrow low-frequency BPFs,
one for the wider mid-range BPFs, and one for the very high-frequency BPFs, (3) use a different LPF
for each channel.

In this lab project, you must use option #3, i.e., a different LPF for each channel. There are two
factors that constrain the cutoff frequency of the smoothing LPF, and these factors vary across the set
of BPFs. The bandwidth of the channel BPF determines the bandwidth of the usable envelope signal;
the nonlinear magnitude operator produces higher-frequency copies of the desired spectrum at integer
multiples of the center frequency.

(b) There is a complication. The magnitude operation produces a signal that is nonnegative, so it has a
nonzero average value. In other words, there is a constant offset, because the DC level is a positive
value. If we view the envelope as containing the interesting temporal variations in the signal, we
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should argue that this constant offset conveys no information. For the filter design, this suggests that
we need a filter that is lowpass-like, but one that rejects DC—maybe another BPF. However, direct
design of such a modified LPF could be difficult. Instead, we can cascade two filters to do the job: the
Butterworth LPF from the previous part followed by a notch filter that removes DC.

A simple, but effective, notch filter can be produced with an IIR system function that has a zero exactly
on the unit circle together with a pole nearby.

H.z/ D 1
2
.1C a/

1 � z�1

1 � az�1

The pole location .z D a/ can be varied to sharpen the notch by moving the pole very close to the
zero. However, the pole must remain inside the unit circle; why? Plotting a frequency response should
demonstrate the notch capability of this filter. Plot four magnitude responses in the same figure, for
values of a D 0:95; 0:98; 0:99; 0:995, showing only the region 0 � O! � 0:25� . For each of these four
filters, determine the band edge frequency O!a where jH.ej O!/j � 0:9 for O!a � O! � � .

(c) When the notch filter is used, DC is eliminated but the notch has a bandwidth, i.e., the width measured
by band edge O!a at the 0.9 level. Assuming that the bandwidth of the notch must be 100Hz or less
when fs D 22:050 kHz, determine the value of the pole a.

(d) Pick one channel and plot three frequency responses: the Butterworth LPF from part (a), the DC-notch
filter from part (c), and the cascade system consisting of these two.

4.2.3 Envelope Modulation

The envelope modulation is done by multiplying the slowly varying extracted-envelope signal by a high
frequency signal that represents the channel (Fig. 6). For the acoustic simulation done in this lab, the
appropriate choice would be a sinusoid at the center frequency of the channel.

Note-1: Excellent sound quality is not the primary objective when implementing the CI filter bank.
Instead, the objective is to create a sound output that portrays how the user of a CI device would experience
sound. On the other hand, the sound output should be intelligible even if the quality is poor.

Note-2: The sinusoidal modulation is an easy way to combine the envelope signals, but it is sensitive to
the DC offset of the envelope. Hence, the DC-notch filter should make the output sound better.

4.3 Testing

The objective of testing is twofold: verify that the system works, and find conditions that “break” the system.
You should perform at least two types of tests with your working system. First, vary the input signal by using
male and female speakers. Describe any differences that you hear by finding cases where the system works
well and other cases where you can observe serious degradations. Show a few spectrograms to help explain
how the system works. Spectrograms would also be useful to compare the final output to the original—a fair
comparison would be to compare to the pre-emphasized original.

The ZIP file CochlearTestSignals.zip contains three signals for testing:

1. greasyWW22k.wav Female speaker

2. catsdogs22k.wav Male speaker

3. furElise22k.wav Piano music
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Second, testing with music input would also be interesting since a patient with a cochlear implant would
have the device optimized for speech, but would be hearing all sorts of other sounds. One issue would
be the bandwidth coverage of the filter bank with respect to the expected range of frequencies in music.
Spectrograms would help in comparing the output to the original input. In your tests you should listen
primarily for intelligibility rather than high quality.

4.3.1 Debugging

Here is one hint on debugging: use a single sinusoid as the input signal rather than a speech signal. Also,
vary the frequency of the sinusoidal test input. When the frequency of the test sinusoid equals the center
frequency of one of the channels, it seems that you should get (almost) perfect reconstruction at the output.
In any event, debugging is simplified because you can analyze how the sinusoid goes through the system,
i.e., there is only one spectral line to track.

4.3.2 Demonstration

Even if you are writing a lab report, a short demonstration of the working system can be performed. The
purpose of the demo would be to show how your system handles music, as well as speech. In a lab report
write-up, you should be able to explain the design decisions that were made when creating the bandpass
filters for the filter bank.
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Lab: Cochlear Implant Simulation with an IIR Filter Bank
INSTRUCTOR VERIFICATION PAGE

For each verification, be prepared to explain your answer and respond to other related questions that the lab
TA’s or professors might ask. Turn this page in at the end of your lab period.

Name: Date of Lab:

Part 3.1 Demonstrate the pre-emphasis filter by showing spectrograms of a speech signal before and after
filtering. Compare the spectrograms and point out changes after filtering.

Verified: Date/Time:

Part 3.2(c) Show the magnitude of the AM signal vs. time. Point out the feature on the plot that would be
called the envelope. Explain the frequency content of b.t/ and b1.t/ versus that of jb.t/j.

Verified: Date/Time:

Part 3.2(d) Explain how you designed the lowpass filter with the filterdesignGUI, and how you used the
filter coefficients. Write the call to the Matlab function filter below. In addition, write out the difference
equation that corresponds to the LPF.

yy = filter(

yŒn� D

Verified: Date/Time:

Part 3.2(e) Plot the output signal from the LPF, and compare to the known envelope. Explain differences.

Verified: Date/Time:
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